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Introduction

Welcome to Tinkercad!
About 20 years ago, I went off to college to study engineering. One of the classes that engineering 
students had to take was a drawing course that required us to use special pencils (not the familiar 
No. 2s) and rulers and straight edges to create hand-drawn schematics of various objects. We 
started out with simple designs like cubes and pyramids and moved slowly but surely into more 
advanced drawings. It was a fun class, but it was also very tedious. I could sometimes erase 
mistakes, but many times it was easier to just start over, especially when I discovered I’d made a 
measurement error early in a complex drawing. 

At the end of the class, the instructor informed us that a special class was being offered the next 
year, called CAD, or Computer-Aided Design (although some students called it Computer-Aided 
Drafting). He said that to get in the class, a student would have to demonstrate some basic skills. 
As an example, the professor taped three large drawings on the wall; each of the drawings showed 
one particular face of a large cube—a top, a side, and a front view. This cube consisted of 9 smaller 
cubes on each face, just like a Rubik’s Cube, as shown in Figure I.1.

These drawings, however, showed that the cube had a few missing smaller cubes, which created 
a strange landscape on a few of the faces of the larger cube. Students had 60 seconds to draw a 
version of this 3D cube using nothing but the front, side, and top views. The professor was testing 
our ability to visualize a 3D object in our head, based on three simple views, and then transfer that 
image to paper.

I didn’t take the test because I wasn’t interested in the class. But the students who did take the CAD 
class said that it was both fun and difficult (a typical description of many engineering classes) and 
that it involved drawing objects on a computer screen by defining points on the object and then 
connecting lines between points. It sounded difficult, time-consuming, and frustrating…but most of 
the students said it was much faster than drawing by hand, as we’d all done in that beginner-level 
class.

Today’s CAD applications are much more advanced than those that existed 20 years ago. These 
applications are colorful, they do much more of the work for you (such as drawing a perfect circle or 
ensuring that a line is exactly 1.275 inches in length), and they allow you to create 3D objects that 
exist on a screen long before they exist as real physical objects.
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FIGURE I.1 A Rubik’s Cube.

Many people complain that learning to use CAD applications is difficult. I’ve tried to teach 
myself half a dozen CAD applications over the past few years, and although I’ve had success 
with them, they’ve been frustrating at times, and mastering them requires a serious time 
commitment. Until very recently, anyone who wanted to use these applications to create 3D 
objects had to put in the time, deal with a lot of frustration, and often pay a substantial fee 
to get the software if their school or workplace didn’t provide it.

But not anymore. Today, a few CAD applications are tailored to beginners and less 
intimidating than their big-brother counterparts. They require less time to master and in 
some cases are even free to use. One of these CAD applications is called Tinkercad.

I first encountered Tinkercad at    Maker Faire ( www.makerfaire.com) back in 2012. I was 
hooked by a number of factors: It was impressive and colorful; using it required only an 
Internet connection and a web browser; using it felt almost like dragging and dropping 
LEGO blocks onto the screen; and it was free. I created an account, began to use Tinkercad, 
and discovered that it’s a pretty good CAD app. It has limitations, but for a beginner-level 
CAD application, it’s an impressive example of how a complex tool can be simplified for 
anyone to use.

What you’re holding in your hands is a book for learning Tinkercad. The popular CAD 
software company,  Autodesk (www.autodesk.com), makers of the commercial and very 
popular CAD application   Autodesk 360, purchased Tinkercad in 2013, and the company 

http://www.makerfaire.com
http://www.autodesk.com
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chose to keep the application free to use—good news to the fans who had already 
discovered the simple CAD app.

Autodesk didn’t just buy Tinkercad; the company has continued to improve the app, adding 
new tools and features, and providing users with free online support via a blog and forum.

If you’re new to CAD applications, this book is for you. If you understand the importance of 
a CAD application but aren’t sure where to start, this book is also for you. Maybe you’re the 
brand-new owner of a 3D printer and are wanting to start designing and printing objects to 
print in plastic—if so, Tinkercad is the perfect tool to get started. (And check out Chapter 8, 
“Printing Your 3D Models,” if you’re not familiar with 3D printers and want to know more.) 
And if you’ve found Tinkercad but are feeling a little confused about where to start, you’ve 
got the right book. I’m going to show you all you need to know to begin creating some 
amazing 3D objects, and hopefully when you’re done with the book, you’ll feel confident 
enough to continue on with any new features introduced to Tinkercad or maybe even move 
on to playing with a more advanced CAD application.

Using Tinkercad truly is one of the easiest ways to experience computer-aided design and to 
create 3D models. You’re about to learn a new skill…and you’re going to have a lot of fun 
doing it. I’ll see you in Chapter 1, “3D Modeling Is Cool!”
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4
Learn Some Modeling Basics

In This Chapter
  The launchpad

  The rocket’s main body

  The rocket’s fins

It’s time to start digging a bit deeper into the workings of Tinkercad, and the best way to learn 
about this amazing tool is to get hands-on with it. Now, before you can go and create your own 
amazing models, you’ve got to realize that there are a lot of basic skills you’ll need to master first. 
This doesn’t mean you can’t create some 3D models right now, however. It just means that it might 
take you a little bit longer.

The better way to learn Tinkercad is to start slow and first learn how to use its most basic tools and 
features. An even better way to learn Tinkercad is to create an actual model as you’re learning the 
ins and outs of the application. And that’s exactly what this chapter is all about. By the end of this 
chapter, you’ll have created all the components necessary for a simple 3D model and you will have 
learned many (but not all) of the standard features that Tinkercad offers. To show you how to make 
the parts of a simple 3D model, I’ve picked a fun little rocket for you to build. Go ahead and open 
up Tinkercad, log in, and click the Create New Design button on the Dashboard.

The Launchpad
This    first model is simple. You’ll be using basic shapes to create a model of a small toy rocket, 
preparing to launch. You’ll need to create the pieces for both the launchpad and the rocket—starting 
with a launchpad that’s sitting on a tiny piece of land. The first thing you’re going to want to do 
is create that small piece of land. As you can see in Figure 4.1, I’m zoomed in quite a bit on the 
workspace. I need to   zoom out a bit so I can see the entire workspace.
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FIGURE 4.1 You can zoom in and out on the workspace.

To    zoom in and out, you can use the + and – buttons indicated in Figure 4.1. A few taps 
on the – button shrinks the workspace a   bit so you can see all of its boundaries, as shown 
in Figure 4.2.

FIGURE 4.2 Zooming out to see the workspace boundaries.

Zoom in/out
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Click    the + button to zoom in and see more detail on a model. If you’re using a mouse that 
has a mouse wheel on top, you can also scroll it away from you to zoom in and toward you 
to zoom out. Finally, if you’re using a Mac touchpad, you can swipe two fingers down to 
zoom in and swipe two fingers up to zoom   out. 

Go    ahead and drop a piece of the launchpad on the screen. To do this, you need to click, 
hold, and drag a copy of the red box onto the workspace. You can find the red box shape in 
the Geometric section of the toolbar that runs down the right side of the screen, as shown 
in Figure 4.3. If you don’t see the red box, click the word Geometric to open the list of 
geometric shapes.

FIGURE 4.3 Dragging a red box object onto the workspace.

When    you drop a shape on the workspace   , it may or may not appear with various controls 
around it, such as arrows or tiny white boxes in the corners. When an object is selected, a 
few controls appear on and around it. In Figure 4.4, I’ve zoomed in on the box from Figure 
4.3 so you can see these controls in more detail. If you don’t see the controls   on your 
screen, simply click the red box, and they appear.

You’ve    dropped a box object onto the workspace, but it might not completely look like one 
from the angle shown in Figure 4.4. It would be nice to rotate the workplane a bit so it’s a 
more obvious that this is a box. To do this, you can use the rotate controls shown i     n Figure 
4.5. Likewise, if you’re a mouse user, you can either press and hold both mouse buttons 
simultaneously while moving the mouse to see the workspace move or press and hold the 
middle (wheel) button; test both to see which works for you. Mac users can press and hold 
two fingers on a touchpad to achieve the same result.
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FIGURE 4.4 Controls allow you   to manipulate an object.

FIGURE 4.5 Using the rotate controls to change the view of the workspace.

White dots

Rotate arrows

Cone

Rotate 
controls
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Find    a suitable angle to view the box object and      then click on the box object to select it so 
the controls are visible once again, as shown in Figure 4.6.

FIGURE 4.6 The controls   on the selected box object.

Compare      the controls shown in Figure 4.4 to those shown in Figure 4.6. With a simple shift 
of the workspace view, you should now see in Figure 4.6 that there are three rotate arrows 
surrounding the box instead      of just the two shown in Figure 4.4.

You’ll learn about the rotate arrow controls in Chapter 5, “Putting Together a Model,” but 
for now I want you to focus on the small white dots that are visible in the bottom corners of 
the box object.

Move      your mouse pointer over any white dot, and a measurement appears. Some dots, such 
as the one in Figure 4.7, displays two measurements. 

As    you can see in Figure 4.7, the length and width of this box object are both 20mm 
(millimeters). This means the base of this box is a square. You can check the height of the 
box by clicking the white dot control on the very top of the box: Move your mouse pointer 
over it as shown in Figure 4.8, and the height measurement appears. 

Because    the height is also 20mm, you’re looking at a perfect cube. But a cube isn’t the best 
place to launch a rocket. You’re going to modify the cube so it’s very flat and a bit larger, 
and you’ll do it by clicking and dragging on those white dot controls. 

Three 
rotate 
arrows
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FIGURE 4.7 White dot controls display measurements.

FIGURE 4.8 The top white dot control reports the height measurement.
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Let’s start with the height. Click and hold on the white dot on top of the cube while 
dragging down. Watch as the cube begins to flatten in size, and the height measurement 
value decreases. Notice also that the length and width remain the same: 20mm. Shrink 
the box object’s height to 1mm and stop. Your      box object should now look like the one in 
Figure 4.9.

FIGURE 4.9 Flatten the box object by dragging down on the top white dot 
control.

You    can verify the height at any time by hovering your mouse pointer over the top white dot 
control again. Once you’re satisfied that the height is 1mm, click and drag on one of the 
white dot controls that make up the corners of the box object until the object’s length and 
width values are both 100mm. When using one of the corner white dot controls, you can 
change both the length and width at the same time. Experiment a bit and see how moving 
the mouse pointer while clicking and holding down on a white box lets you change the 
length and width simultaneously.

Your box shape should end up looking like the one in Figure 4.10, at 100mm in both length 
and width and      1mm in height.

In    Figure 4.10, the launchpad extends beyond the workspace. This isn’t a problem, but it 
can affect your view when you zoom in and out of the workspace. Ideally, you want to try 
to keep your models within the boundaries of the workplane for easier viewing. To move an 
object   such as the flattened launchpad, simply click and hold on any part of the object’s 
surface (but not on any of its controls) and drag it and release it where you want it. 
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FIGURE 4.10 The rocket’s launchpad is done.

This is a    good time to point out just how easy it is to change the color of a selected object. 
When you have an object (such as the launchpad) selected, click the Color button indicated 
in Figure 4.11 and pick a new color. (You can use the Custom link to create a unique 
color if you like.) Figure 4.11 shows that I’ve changed the launchpad’s color to green and 
centered the object in the    middle of the workplane.

FIGURE 4.11 You can drag and drop model pieces anywhere on the workspace.

Color button

Custom button
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Before    you move on to creating the pieces of the rocket, I want to give you some more 
practice with dropping objects on the workplane and modifying their sizes. To get this 
practice, you can create the launch scaffolding. This will consist of three pieces that will 
eventually be stacked. Just create four blue objects using the box shape object and give
them these dimensions (length x width x height):

Scaffold1: 10mm x 10mm x 10mm 

Scaffold2: 7mm x 7mm x 20mm

Scaffold3: 4mm x 4mm x 15mm

Scaffold4: 30mm x 5mm x 2mm

Drag and drop these launchpad scaffolding pieces around the edges of the workspace, as 
shown in Figure 4.12. You’ll put these together in Chapter 5, along with the pieces of the 
rocket that you’ll be    creating next.

FIGURE 4.12 The scaffolding pieces, sized and ready for assembly.

The Rocket’s Main Body
Don’t   worry, you’re not going to be re-creating the Space Shuttle in Tinkercad…although 
that would make a great advanced project for you to consider. Instead, you’re going to 
create the pieces for a small and simple rocket that will consist of the main body, the 
engine, and three fins. 
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When the scaffolding is assembled, the height of the assembly will be 47mm. The rocket will 
have a height of 45mm. Keep this in mind as you create the main body, engine, and fins.

It can often be useful to have a hand sketch of your model (or a photo of a real-life object), 
and Figure 4.13 gives you the basic idea of the rocket you’ll work on creating. Your version 
doesn’t have to look exactly like mine, but do try and follow along with the hands-on steps 
so you get some practice with the Tinkercad   tools and features used here.

FIGURE 4.13 A sketch of the rocket 3D model to be designed.

As   you can see, the largest part of the rocket will be the main body, and I’m going to start 
with that shape. The easiest way to obtain this shape is to drag and drop a Sphere object 
on the workspace and use the white dot controls to    modify the shape. Figure 4.14 shows 
that I’ve dropped a sphere object onto the workspace.

Like   a box, a sphere also has the white dot controls appear when you select it. Unlike a box 
object, however, a sphere’s measurements are related to its diameter (when it’s a perfect 
sphere). You can click and hold on any white dot and manipulate the shape of the sphere 
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as desired. After some playing around, I managed to end up with an elongated cigar-shaped 
object, as shown in Figure 4.15, with length and width of 14mm and height of    30mm.

FIGURE 4.14 A sphere object, ready to be modified.

FIGURE 4.15 The rocket’s main body is cigar shaped.
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NOTE
You may be   wondering if you need to save your work at this point. Don’t worry. 
Tinkercad is constantly saving your progress. However, to save your progress 
manually, you can click the Design menu and then click the  Save button. 

Now let’s move on to the engine. Creating this part involves simply sizing a small ring that 
will be placed on the bottom of the main body. You’ll learn in Chapter 5 how to properly 
line it up and center it on the main body. For now just drag and drop a tube object (which 
you find at the bottom of the Geometric section) onto the workspace and give it a diameter 
of 8mm and a height of 2mm. 

Because you want to keep the diameter of the ring constant, the length and width must 
be the same value. If you hold the Shift key down on your keyboard as you drag one of the 
white dots inward, the length and width are locked together and shrink at the same rate. 
Figure 4.16 shows the completed   ring.

FIGURE 4.16 The engine ring, resting on the workspace.
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The Rocket’s Fins
Now    it’s time for the fins. For the fins, you’ll need to use an interesting little trick to create 
the curves, but once you’ve made one basic fin, you’ll be able to make two exact copies of 
it to save time. The trick to the fins involves creating what’s called a hole object and using it 
like a cookie cutter to remove unwanted areas of a solid object.

You’ll find as you continue to work with Tinkercad that the application sometimes requires 
you to be a bit creative in order to get the shapes you want. As you can see by browsing the 
Geometric section of the toolbar, there is no fin shape. But that’s not going to stop you. 
You can first focus on the outer     curve of the fin shown in the sketch in Figure 4.17.

Outer
Curve

Inner
Curve

FIGURE 4.17 A fin will be a small sliver of a larger object.

As    you can see, the outer edge of the fin is actually a piece cut out of a stretched circle. 
You’ll first create a flattened cigar-shaped oval that has the curve you want for the outer 
edge. You’ll do this by dropping a thick tube object on the workplane, as shown in 
Figure 4.18.



CHAPTER 4: Learn Some Modeling Basics
58

FIGURE 4.18 Start with a thick tube object.

Flatten        the tube to 2mm in height and stretch the tube to get the curve you want. Figure 
4.19 shows that I’ve flattened the tube to 2mm and dragged one of the other white dot 
controls to give the finished oval dimensions of 18mm wide by 35mm long.

FIGURE 4.19 The flattened oval is the start of a fin.
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Next          , cut the tube object in half vertically by creating a 2mm-thick rectangle to cover half of 
the tube. Figure 4.20 shows that I’ve dropped a box object onto the workspace, shrunk it to 
2mm in height, and matched its width and length to that of the tube object. (The width is 
18mm and the length is 35mm.)

FIGURE 4.20 The flat rectangle will help cut the oval in half.

Now       , here’s the trick: Select the rectangle object and then click on the  Hole button 
indicated in Figure 4.21. Notice that the rectangle will change from a color to a clear 
outline.

Now       , drag the rectangle so that it covers half of the oval object. Figure 4.22 shows the 
rectangle object overlapped over the oval.
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FIGURE 4.21 Turn the rectangle into a hole object.

FIGURE 4.22 Overlap a solid object with a hole object.

Hole buttonClear rectangle
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Finally       , drag and select both objects so they are outlined. Likewise, you can hold down the 
Shift key and click on each object to perform a multiple-select action. Figure 4.23 shows 
that the clear hole object and the orange oval are selected.

FIGURE 4.23 Select both objects to be combined.

Click        the Group button. This instructs Tinkercad to combine the two objects into a single 
object       (see Figure 4.24). 

As        you can see, the outer hole objects will be treated as empty space and will delete or erase 
any solid objects they encounter. This means that half of the oval object will disappear. 
Keep in mind that Tinkercad must perform some calculations to determine where solid 
material and a hole intersect, and this can sometimes take a minute or two for complex 
combinations. When the calculations are done, the final piece that is left exists as a single 
object, as shown in Figure 4.25     .

Group
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FIGURE 4.24 Group two or more objects together to create a single object.

FIGURE 4.25 The final object consists of material not combined with the hole 
object.
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NOTE
While the calculations for the grouping of the two objects is being done by Tinkercad, 
you might think that nothing is happening and hit the Undo button in haste. Be 
patient. Sometimes a merge can take a few seconds and other times a few minutes. 
Rest assured: If you clicked the  Group button, Tinkercad is busily trying to figure out 
what to keep and what to delete. The flipside is that a click of the  Undo button can 
also take some time to undo the grouping. If the grouping took more than a minute to 
complete, expect the Undo button to take about the same time.

Now             take a look at Figure 4.26, and you’ll get an idea of how the final shape of the fin will 
be accomplished.

Hole
Object

Inner
Curve

FIGURE 4.26 A sketch of how the final fin will be made.
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NOTE
The fun thing about the Group button and the Hole button is that you can keep using 
them over and over, refining the shape of an object as you slowly delete away bits and 
pieces by merging a hole object with a solid object. One suggestion is to change the 
color of an object before turning it into a hole object. While both objects are solid, the 
distinct colors will help you distinguish between each object as you merge them. Once 
you’re happy with the merge, you can convert one object to a hole object—you don’t 
have to convert it to a hole object before the  two objects are merged.

To        make the inner curve of the fin, you need to create another unique object on the 
workplane and then convert it to a hole object. Then you will group the new hole object 
with the half oval in Figure 4.25, which will yield the final desired fin shape. The dimensions 
of this second oval piece are 49mm x 64mm. Figure 4.27 shows a new oval object, flattened 
to 2mm and shaped to get the desired inner curve.

FIGURE 4.27 A fin will be a small sliver of a larger object.

After        selecting the new shape and clicking the Hole button, drag the two objects together, 
as shown      in Figure 4.28. You can see that the final shape of the fin will be the bit that’s not 
covered by the hole object.

When        you’re happy with the fin shape, select both objects and click the Group button 
again. The hole object disappears, along with any solid sections of the oval object, leaving 
only the final fin shape, as shown in Figure 4.29.
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FIGURE 4.28 Creating the final fin requires another hole object.

FIGURE 4.29 The final fin shape.
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Now        all that’s left is to create two more fins. The fin should already be selected because 
when you group two objects, the final object is always selected when the grouping task 
is complete. You   can simply make a copy of the object by pressing Ctrl+C on a Windows 
computer or Command+C on a Mac. You can also click on the Edit menu, as shown in 
Figure 4.30, and then click the   Copy option. 

FIGURE 4.30 Copy the fin object and make two more.

Select the Edit menu   again and click the   Paste option to have a copy of the fin object 
placed on the workspace. Instead of using the menu, Windows users can press the Ctrl+V 
shortcut, and Mac users can press Command+V.

A    pasted copy usually overlaps the original by a small amount. Just click the copy and drag 
it to a blank area of the workplane. Figure 4.31 shows my three final fin objects.

Zoom    out a bit, and you can see all your parts ready for assembly to make the rocket and 
the launchpad, as shown in Figure 4.32. 

Up next in Chapter 5, you’ll learn how to combine the parts. This will involve some stacking 
and centering of objects as well as some rotating of parts (such as the fins). 
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FIGURE 4.31 Three fins, ready to be attached to the rocket.

FIGURE 4.32 All the objects are ready for assembly.
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Before you leave this chapter, think about some of the new skills you have acquired in 
Tinkercad:

  Dragging an object around on the screen—This involves simply clicking and holding on 
an object and placing it where you want it on the workplane.

  Zooming in and out—This will be useful when you want to get closer to a particular 
piece (such as one of the fins) for detail work or to view all your work at once.

  Resizing objects—By using the white dot controls, you learned how to modify an 
object’s width, length, and height.

  Changing color—Changing the color of an object can make distinguishing parts of the 
larger model easier. Once parts are combined, a single color can be selected.

  Converting an object to a hole object—By creating an object and turning it into a hole 
object, you can remove material from a solid object.

  Selecting multiple parts—You can select more than one part at a time by holding down 
the Shift key and picking them one by one or else dragging a rectangle around them.

  Copy and paste—Copying and pasting copies of an object will save you lots of time 
when you begin making more complicated models.

You’ll be learning many more Tinkercad skills in the chapters to come, but for now, feel 
free to create a new design of your own and play around with the other shapes available in 
the Geometric section. Take some time to experiment and use the skills you’ve acquired so 
you’ll feel confident using them throughout the remaining chapters. See you in Chapter 5.
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